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Participants
This course is aimed at:

• Users of EXO Business.

Prerequisites

Basic PC experience is required.

Understanding of payroll processes and procedures.

Instructional method

The instructional method combines trainer-led demonstrations with hands-on student 

practice. You will work through a series of examples. Each unit concludes with a Review 

Task. 

Conventions used in this manual

• Objects such as buttons or icons that you must click or select are shown in bold.

• Information to be entered (typed in) is shown in bold and italics.

• Keyboard keys are shown as , , etc.

Screenshots in this manual are for illustration purposes only and may differ from those in the actual product 
due to configuration settings.
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Symbols used in this manual

Symbol Name This symbol tells you... 

Practice task

Review task

… to complete a task to practice the skills you 

have just learnt, or as a review task at the end 

of the unit to consolidate what you have learnt.

Written Review task … to complete written questions to review the 

content covered in the unit.

Optional Challenge … to complete this task if you have finished 

early and are looking for an extra challenge.

Tip … about helpful tips

Note … to take note of an important message.

Warning … about potential problems to be aware of.

Important … to pay attention to an important notice.

New … where features are new for EXO Business.

Reference … where to go to find more information.

Skills Checklist … to tick off a list of skills that you have learnt 

during the unit.
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Objectives

In this coure you will learn how to process payments receiptes from debtors and how to 

make payments to creditors.

Upon completion of this course you will be able to:

• Enter general ledger transactions.

• Establish general ledger budgets

• Review general ledger batches

• Undertake a bank reconciliation

• Backup the data file

• Run foreign exchange variance calculations

• Post sub-ledgers to the general ledger

• Reconcile sub-ledgers to the general ledger.

• Roll end of period.

• Prepare standard management reports.
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Navigational & Function Keys

MYOB EXO Business can be navigated by keyboard or mouse, however a combination of 

both is generally used. The standard keyboard convensions for Windows are used, with a 

few MYOB EXO Business-specific options.

Windows Navigation Keys

TAB Moves from field to field, column to column

SHIFT+TAB Moves backwards from field to field, column to 

column

ENTER On open dialogue boxes, automatically select the OK 

button.

ARROW KEYS Moves around a grid, or up and down a list.

PAGE UP, PAGE DOWN Moves between the “sections” of some screens, 

such as moving from the invoice header to the body 

to the end.

ALT + (Underlined Letter) ALT key plus the underlined letter on a field label 

activates that function, e.g. ALT + N within a the 

debtor account screen creates a New Debtor.

MYOB EXO Business Function Keys/Shortcut Keys

F1 HELP

F3 Debtor accounts search screen

F4 Sales Order search screen

F6 Debtor Invoice entry screen

F7 Invoice Number search screen

F9 Enter sales message (within an order/invoice)

F10 Alternative delivery address (within and order/invoice)

RIGHT + CLICK Right-click on Exogrid header or certain field to acces additional 

functions or options.

CTRL + 0 Create one-off stock items (within an order/invoice)

CTRL + L Stock level enquiry (within an order/invoice)

CRTL + N New line narrative (within an order/invoice)
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Shortcut Menus
A shortcut menu is available at the top of the main window of each EXO Business module. 

This menu offers quick access to commonly used functions, e.g. accessing the Debtors 

Masters, accessing the Stock Masters, creating a new Sales Order, etc. Any menu item that 

has a shortcut key assigned will automatically appear in the shorcut menu.

Shortcut Menus
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General Ledger 
Transactions

This unit will provide an 
overview of the General 
Ledger.

By the end of this unit, you will be able to:

View General Ledger transactions

Access the GL Trial Balance tree

View, reverse, copy and edit General Ledger 

batches
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Overview

Transactions

The transactions show 

details of daily business 

activity.

Stock Transactions

• Stock purchases

• Stock Sales

• Stock Adjustments

• Stocktake

Stock Ledger

Posting moves 

transactions to 

the GL for 

reporting. 

Transaction detail 

is maintained.

General Ledger

The GL accounts show a 

summary of business 

activity at a particular 

point in time.

Creditor 

Transactions

• Stock purchases

• Expense purchases

• Payments Made

• Refunds

Debtor 

Transactions

• Stock Sales

• Service Sales

• Returns

• Payments Received

General Ledger 

Transactions

• GL Transaction entry

• Integrated Cashbook 

(G ,D ,C ,X ,I)

• Banking Batches

• ForEx Calc

• Bank Reconciliation

Sub-Ledgers

The sub-ledgers “hold” 

the transactions in the 

relevant accounts until 

ready to be posted.

Creditors Ledger

Debtors Ledger

Stock Items:

AIRFIL01

ALARM05

DISBRA01

Creditor Accounts:

Car-Part.com

G Grey Accountants

Office Products Depot

Debtor Accounts:

All Part Automotive

Aussie Spares

Cash Sales

Post Stock 

to GL

Post Creditors 

to GL

Post Debtors to 

GL

GL Accounts

• Stock on hand

• Stock Clearing

• Cost of Sales

• Stock Adjustments

GL Accounts

• Creditors Control

• Stock Clearing

• Expenses

• Banks

• GST Paid

GL Accounts

• Debtor Control

• Sales

• GST Collected

• Bank

GL Accounts

• Bank

• Asses

• Wages

• PAGY Witholding

• Depreciation
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Introduction to General Ledger

The General Ledger is a group of accounts that provide a summary of business 

transactions. Information from the General Ledger is used to review business 

performance, primarily in reports such as the Profit & Loss statement and the Balance 

Sheet.The GL accounts can fall into one of two main categories:

Profit & Loss accounts

• Combine to show profitability of a business.

• Sales, cost of sales, overheads, etc.

Balance Sheet accounts

• Combine to show net worth of a business.

• Assets, liability, equity, etc.

Most transactions come through to the General Ledger from the individual sub-ledgers 

(Stock, Creditors, Debtors) via the Post to GL function. This is generally undertaken at the 

end of each period in preparation for rolling the end of period.

This means that transactions entered into EXO Business via sales, purchases or stock 

adjustments are not visible in the General Ledger until the Post to GL function has been 

carried out. This will be reviewed later in this module.

Some business transactions are not recorded by entering sales, purchases or adjustments 

to stock. These are referred to as journal entries and include items such as depreciation, 

loans to shareholders, tax payments, etc. They can be entered via General Ledger 

Transaction Entry or Integrated Cashbook.
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Accounting Periods & Posting

Accounting Periods
EXO Business is a period-based accounting system. While transaction dates are recorded 

for reference purposes, it is the period to which a transaction is posted that determines 

when it is reflected in the financial statements.

In accounting terms, periods determine the intervals at which the financial statements will 

be prepared. Most commonly periods reflect the calendar months, however this can be 

varied to suit your business.

End of Period
End of Period is the point in time where we total transactions to determine profitability 

and net worth of the business. 

The End of Period is the point in time where we total the transactions that have occurred 

in order to determine the profitability for the period (Profit and Loss) and the net worth of 

the business (Balance Sheet). EXO Business handles this automatically via the End of 

Period roll.

Once a period has been rolled via the End of Period process, it is still possible to post 

transactions to prior periods. However transactions cannot be entered into a new period 

until an end of period is performed (i.e. you cannot post to future periods).

Posting
Posting is the process of telling EXO Business which period you want a transaction to 

belong to.

Posting is carried out as frequently as necessary in order to reflect transactions in the 

General Ledger. Sales, purchases, banking batches, etc. will not be reflected in the general 

ledger until posting has been carried out.
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Viewing Transactions in the GL

General Ledger Main Screen
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Accounts / General Ledger
The General Ledger accounts can be viewed by opening the GL account screen and 

searching for a particular account or all accounts. Accounts can be opened by double-

clicking to view sub-accounts, transactions, budgets, history notes and an analysis of the 

movements in that account.

General Ledger Account: Sales

Icon Description

Click on this icon to add a new sub-accounts.

The Allow journals option can be set independently at sub account 

level

Click on this icon to edit the selected sub-account.

The Allow journals option can be set independently at sub account 

level

‘
Click on this icon to delete the selected sub-account.

Select this icon to view, delete or calculate movements.
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To view transactions, click on the relevant account or sub-account and click the 

Transactions tab.

From the transactions screen you can:

• Print a list of the transactions. 

• Print to a grid (which can then be copied to the clipboard and taken across to a 

spreadsheet program for further analysis).

• Right-click on a transaction to:

• View the GL batch that it came from (e.g. debtors banking batch) 

• View source account (e.g. debtor account) 

• View source transaction (e.g. an invoice or realised foreign exchange gains or losses)

• Edit transaction references (as entries cannot be edited once posted to the GL, only 

the transaction reference can be changed)

• Select the check box Group Transactions to group the data in the EXOGRID. The 

Grouping option to the right of the Group Transactions allows you to choose how you 

want to group your data

In addition to the main GL account screen, other utilities are available to review GL 

transactions. They are:

• GL Trial Balance Tree

• GL Batch Review

General Ledger Sub Account: Electrical Sales Transactions
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GL Trial Balance Tree

Transactions > General Ledger > Trial Balance Tree

The GL Trial Balance Tree is useful in creating a dynamic trial balance report, but it can 

also be used to review transactions, primarily by account and period range.

Once the trial balance tree is opened, click on the required account to open the 

transactions window for that account. You can then view the transaction details for each 

branch if required.

The Trial Balance Tree can also be useful for conducting a check of GST collected and paid 

to quickly determine the amount payable. 

1 Click on Current Liabilites and then  to view all the liability accounts.

2 Click on the GST Collected or GST Paid account and then click the  icon 

if you need further detail.

3 Click  to collapse the subaccounts and view only the main accounts.

Trial Balance Tree - Liabilities including GST Collected and GST Paid
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GL Batch Review

General Ledger screen > GL Batch Analysis > GL Batch Review Utility

The GL Batch Review function allows searching for GL batches based on specified search 

criteria, such as date or period range, source or amounts. 

The Advanced Search tab also allows text searching of the reference fields. This can be 

particularly useful if you want to review all Cashbook entries, or find all Adjustments 

entries for a particular period. Note that if you set criteria into the Advanced Search 

option it will remain there until deleted (clicking back to the Search tab will not remove 

the criteria).

View a GL Batch
Once the GL Batch Review screen has been opened, find the GL batch you wish to view 

and then click on the  icon in the menu bar (or double click). This will open the batch 

for review.

Reverse GL Batch
The batch review screen enables reversing of batches, for example if you have posted a 

journal entry to the wrong period you can reverse the entry and then redo the journal.

1 Search for the batch that you want to reverse. 

2 Select the batch and then click  in the menu bar.

GL Batch Review
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3 A new batch transaction screen will appear, with full reversing journals for the 

batches. Make sure that the ledger period you are posting to matches the period of 

the batch you are reversing. Click  to post the reversing entry to the GL.

Note that batches such as Post Creditors to GL and Post Debtors to GL cannot be reversed 

easily as EXO Business does not normally allow journal entries to the Debtors or Creditors 

control accounts. If you wish to change this configuration, see your implementing partner.

Copy GL Batch
It may be simpler to copy a previous GL batch than to re-enter it (as in the scenario above 

when the original batch was posted to the wrong period).

1 Search for the batch that you want to copy. 

2 Select the batch and then click  in the menu bar.

3 A new batch transaction screen will appear, with a full copy of the original batch. 

Check the period you are posting to and click  to post the entry to the GL.

Edit GL Batch Reference
While GL batches that have been posted cannot be edited, the reference field can be 

changed. Search for the batch that you want to edit, select it and click on the reference 

icon in the menu bar. Update the   information as required.

New GL Transaction
1 A new GL transaction can also be created from the batch review screen. Click on the 

 icon in the toolbar to go to the GL Transaction Entry screen. See the 

following section on entering GL transactions.
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Skills checklist
Tick the skills that you have learned in this unit.

Skills

View general ledger transactions

Access the GL Trial Balance Tree

View, reverse, copy and edit GL Batches
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Entering 
GL 
Transacti
ons

In this unit you will learn 
how to enter General 

Ledger transactions

By the end of this unit, you will be able to:

Enter GL Transactions using the Integrated 

Cashbook.

Enter GL Transactions using the General Ledger 
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Transactions Entry screen.

Save a recurring or suspended batch.

Recall a recurring or suspended batch.

Delete a recurring batch.

Use a super batch.
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Enter Transactions to the GL

Transactions that are not processed by debtors, creditors or stock adjustments can be 

entered in one of two ways:

Integrated Cashbook 

Used for entry of information from the bank statement, e.g. interest.

Enter GL journals 

Used for entry of accounting journals that are not based on a direct activity of the 

business, i.e. depreciation.

N O T E

Transactions entered in this way are immediately visible in the General Ledger and do not 

require a separate posting.
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Integrated Cashbook

The integrated cashbook is generally used to key information from a bank statement. 

Entries can be coded to

• D (Debtors)

• C (Creditors)

• IN (Income)

• EX (Expense)

• GL (General Ledger)

It is used for foreign currency bank accounts, bank fees and interest and other cash 

transactions which have not already been processed through debtors or creditors or the 

debtors banking batches.

I M P O R T A N T

Integrated cashbook entries do allow for tax (GST) in entries categorised to Debtors, 

Creditors, Expenses or Income, but not entries coded to GL.

Integrated Cashbook entries is covered in Receivables and Payables.
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General Ledger Transaction 
Entry

Journal entries can be as simple or complex as the business requires, however GST cannot 

be easily accounted for using GL Transaction Entry. If there is a GST component it is best to 

use Integrated Cashbook or process the transaction through debtors or creditors.

To enter GL transaction

Transactions > General Ledger > GL Transactions

Use the following procedure to enter a General Ledger transaction. In the following 

example we have used depreciation of computer equipment.

1 Open GL Transaction screen.

2 Create new GL Entry by clicking on New.

T I P

Click on the  button to paste transactions from the clipboard.

3 Enter batch header details. Transaction date, period, your initials, a reference.

• Auto Reverse. Select this option if this is to be an auto-reversing journal entry. (Auto-

reversing journals may be used to account for unbanked cash and are also used to 

account for foreign currency unrealised gains and losses).

GL Transactions Entry - multi-branch depreciation
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N O T E

When posting an auto-revering General Ledger Transaction, the user will be prompted to 

post the reversal to the next period. If the period is locked or does not exist, a warning 

message will be displayed and the batch will remain unposted until the period is unlocked 

or created.

N O T E

The reversing entry for auto-reversal journals is generated when the End of Period roll is 

carried out. See your Implementing Partner if you wish to generate the reversing journal at 

will.

• Repeat Branch. Select this option if you are entering multiple journals for the one 

branch. This will automatically enter the branch code (based on your first entry) when 

entering multiple journals.

• Print transactions. Select this option if you wish to automatically print the 

transactions following Post to GL

4 Complete journal entries as appropriate, ensuring that the sum of debits and credits 

equals zero. (NB: The details column can be overtyped with a more detailed 

narrative).

5 Post the entries. If you are ready to post the entries straight away, click  to 

save the transactions in the batch and post to the GL. If you are not ready to post 

the transaction to the GL, refer to ‘Recurring and Suspended Batches’ on page 19 for 

instructions on saving Recurring or Suspended batches.

6 Confirm posting. Click Yes to confirm batch posting. The system will assign a batch 

number and present the print dialog box for you to print the batch.

While cash-based entries to the general ledger can be made via Integrated Cashbook, we 

often use the General Ledger Transaction Entry to enable a more detailed analysis of the 

transaction.

I M P O R T A N T

Entries that contain a GST component should be entered through Integrated Cashbook or 

debtor/creditor transactions.
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Recurring and Suspended 
Batches

If you are not ready to post the journal entries immediately, you can save them as either a 

suspended or recurring batch. 

A Suspended Batch allows you to save the batch details for recall at a later date. Once 

recalled it can be edited prior to posting to the GL. Once posted, the suspended batch can 

no longer be recalled.

A Recurring Batch allows you to save the batch details as a template for recall at a later 

date. Once recalled it can be edited prior to posting to the GL. Once posted, the recurring 

batch (template) can be recalled for future postings (i.e. monthly payment of insurance 

expenses).

To save a Suspended or Recurring Batch

1 Click the  as button in the toolbar and choose Recurring or Suspended 

batch. The batch name will be taken from the Reference field in the batch header.

Save as Recurring or Suspended Batch
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To recall a Suspended or Recurring Batch

1 Click on the arrow next to the Open icon in the menu bar.

2 This will display a list of suspended or recurring batches.

3 Select the appropriate batch and click on the Load button.

4 Edit the recalled batch as required.

5 Once you have made the adjustments you require, click  to post the entries.

Load Recurring or Suspended Batch

Load Suspended or Recurring Batch screen



© Copyright 2013 MYOB Technology Pty Ltd

Unit 8.62—Entering GL Transactions

 21

To delete a Recurring Batch

1 To delete a batch from your list of recurring batches, simply open the recurring 

batch, select it and click the Delete button. This will not delete any prior posted 

batches, it will simply remove the ‘‘template’’ GL transaction from your list of 

recurring batches.
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Using Super Batches

When a recurring batch has been setup it can be recalled at any time, amended and 

posted. You can also recall a group of regular batches into the one ‘‘super batch’’ for 

editing and posting if preferred. This may make it easier to review and post a group of 

batches on a regular basis. 

First select the recurring batches you wish to edit (use the CTRL key to select multiple 

rows). Entry of salaries is probably the most common example of Super Batches, however 

the following shows an alternate example of GL entries that need regular posting. 

Once the recurring batches are selected, click Load to load the batches into the one Super 

Batch.

Load recurring batch screen

Load Super Batch
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The loaded batches can then be edited and posted as required. Once created, the super 

batch will be posted as a single batch.



© Copyright 2013 MYOB Technology Pty Ltd

GL, Reconciliation and End-of-Period EXO Business

 24

Skills checklist
Tick the skills that you have learned in this unit.

Skills

Enter GL Transactions using the General Ledger 

Transactions Entry screen

Save a recurring or suspended batch

Recall a recurring a suspended batch

Delete a recurring batch

Use a super batch



© Copyright 2013 MYOB Technology Pty Ltd

 25

Reports

In this unit you will learn 
how to set up General 
Ledger Reports

By the end of this unit, you will be able to:

Set up General Ledger Reports

Set up General Ledger Report Batches
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General Ledger Reports

EXO Business has many predefined reports using the Clarity report writer. Some of the 

more commonly accessed reports can be viewed via the reports drop down on the lower 

left hand side of the EXO Business main screen.

Customisation of existing reports or writing of new reports is possible using Clarity, 

however Clarity is quite complex and it is recommended to either see your implementing 

partner or attend a course on Clarity.

Alternatively you can create links from EXO Business to Excel to provide additional 

flexibility in report formatting.

However if you wish to set up some simple reports that are largely variations on existing 

GL reports, the GL Reports utility offers some useful customisation features.
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Setup GL Reports

Reports > General Ledger Reports > Setup GL Reports

The following provides an overview to setting up a customised GL report. Report headings 

and the format of the report content can be adjusted.

Columns can be added with additional information (e.g. additional periods). 

1 Open the utility Setup GL Reports. 

2 A list of predefined reports appears.

3 Select the report you wish to customise.

4 Copy the report (Edit > Copy Report or click on the  icon in the menu bar). 

5 Click Yes to confirm. The copy will now be at the bottom of the report list, e.g. Copy 

of P&L Report - All Branches.

6 Open the report you wish to edit by double-clicking.

Set up GL Reports
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7 Enter the new report name and make adjustments to the report layout as required:

• Secondary Heading: The name that appears under the report name (e.g. Report).

• Period End Descriptor. Select from the drop down list.

• Report Units. Select from drop down. You may want to report in 1,000’s rather than 

single units.

• Decimal Places. The drop down list offers from zero to three decimal places.

• Suppress Zeros. Suppresses lines with zero values if selected. 

• List Sub Accounts. Reports on the sub accounts if selected.

• Header Options. Select the appropriate header options, particularly repeat header to 

repeat the header on each report page.

• Use Clarity Formatting, Deliver to Excel and Period in same Financial Year formatting 

options can now be stored within each report.

• A Report Code is used to easily identify reports from within a report drop down list

• The Validate at Runtime option will display the validation messages at the end of a 

report when previewed or run. They will also appear in the warnings section on the 

right of the settings tab.

To add a New Column to the GL Report

1 Add a new column as required, for example an additional period 

Set up GL Reports - Report Settings
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2 Click on the Rows And Columns tab.

3 Right-click on the report columns grid and select new column 

4 In the Type drop down, select Period.

5 Use the arrow keys to select the period number that you wish to add 

6 Order periods from oldest to newest option affects the ordering of columns. This 

option is applied to columns where the type is set to either MOVING FRAME OF 

PERIODS or PERIOD.

7 Click OK.

• Preview Report. Click the Preview button to check that the report generates 

according to your requirements.

T I P

.Four standard column types are available to provide the ability to report on financial quarters in GL 

Reports. The columns are named Quarter, Quarter Totals, Quarter Budget and Quarter Budget Totals

•

To add a New Row to the GL Report

1 Add a new row as required, for example a narrative row.

Set up GL Reports - Settings - Rows and Columns
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2 Click on the Rows And Columns tab.

3 Right-click on the report rows grid and select new row.

4 In the Action Type drop down, select Insert Narrative.

5 Enter your row narrative text in the Narrative Section.

6 Click OK when finished.

Set up GL Reports - Add Narrative Row
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Run GL Reports

Reports > General Ledger Reports > Run GL Reports

GL Reports can be run from either the menu option outlined above or as part of a GL 

report batch (outlined in the next section).

Once the Run GL Report screen is opened, select the report you wish to run, the period 

you wish to run it for and any other parameters required. The report can then be printed 

by clicking on the Print icon.

N O T E

Preconfigured GL reports can be saved as a .CLR file and run via the menu. See your 

Implementing Partner.

Run GL Report screen
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General Ledger Report Batches

Set up GL Report Batches
Reports > General Ledger Reports > Setup GL Report Batches

The GL Report Batches utility enables multiple general ledger reports to be run together. It 

uses the GL Reports that have been setup via the Setup GL Reports function. GL Report 

Batches can comprise a combination of different reports (e.g. Balance Sheet and P&L) or 

may include a series of the same report with different parameters (e.g. an individual P&L 

report for each branch).

The reports can be sent to a printer or to a file (e.g. PDF file for reading with Acrobat 

Reader).

1 Open the utility Setup GL Report Batches.

2 View existing batches. The first screen lists any existing report batches (there are 

none setup by default and this will generally be blank until you create your own.) 

Any that are listed here can be edited or run. 

3 Create new report batch. Click New.

4 Enter a batch description to define the purpose of the batch (e.g. Month End 

Reports.)

5 Enter the period on which you are reporting. The period set here applies to all the 

reports in the batch. If you want to mix periods within the report batch, you will 

need to specify them within the batch line. 

GL Report Batches
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6 Add the reports you require. Click on the Report column of the grid to choose pre-

existing GL reports from the drop down list. The drop down list of reports becomes 

available after pressing the Spacebar or the Enter key.

7 Review the details in each column for each report to ensure they meet your criteria:

• Period. Choose a different period from the one specified in the header if required.

• Budget Code. Select the budget for which the report is to be run from the drop down 

list (Spacebar or Enter to recall the list). This is not a required field but should be used 

for reports that use budget columns. 

• Branch Nos. If branches have not already been defined in the report itself, then right-

click on the grid to select required branches (click in the checkbox to select). 

• No Zero. Set to ‘‘Y’’ to suppress lines with zero values.

• Sub A/C. Set to ‘‘Y’’ to report sub-accounts on separate lines.

• Clarity. Set to ‘‘Y’’ to view the report using Clarity .

• Save to File: Set to ‘‘Y’’ to save the report to a file instead of printing. (The location of 

the saved report files is configured in your ExoConfig settings. See your implementing 

partner.)

• Printer name. Leave this blank to use the default printer, or right click on the grid (or 

ctrl ‘P’ ) to select a printer.

• Copies. Specifies how many copies of the report to print (defaults to 1).

• Save the batch. Click Save. The file name of each saved report uses the format:

Set up GL Report Batch



© Copyright 2013 MYOB Technology Pty Ltd

GL, Reconciliation and End-of-Period EXO Business

 34

GLReport<ReportNo>_<Date>_<Time>.<file extension>, e.g. 

GLRep2_20100228_15550961.pdf

Run GL Report Batch
Reports > General Ledger Reports > Run GL Report Batches

Report batches can be run from either the batch setup screen using the Run icon or from 

the menu path outlined above.

T I P

Entering “?” into the Batch no(s) field and pressing TAB or ENTER opens up a search window where 

single or multiple batches can be selected.

N O T E

GL Report batches can also be set up to run as a scheduled task at regular intervals. See 

your Implementation Partner.
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Skills checklist
Tick the skills that you have learned in this unit.

Skills

Set up General Ledger Reports

Set up General Ledger Reports Batches
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Bank Reconciliation

In this unit you will learn 
how to complete a bank 
reconciliation.

By the end of this unit, you will be able to:

Complete a manual bank reconciliation.
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Overview

The bank reconciliation function in EXO Business has been designed so that accounting 

staff can manage the company bank accounts.

While most of EXO Business is a period based system, by its nature the bank reconciliation 

function is date based. It can be carried out at any time before or after the end of period 

procedures.

The reconciliation can also be carried out at whatever regular interval suits your business 

requirements (ie weekly, fortnightly, monthly). Generally the higher the number of 

transactions in your business, the more frequently the reconciliation should be carried out 

in order to highlight any issues. A separate reconciliation needs to be undertaken for each 

bank account that you operate.

Bank reconciliation can be run using either of the two following methods:

1 Manual. For working from a hard copy, or printed, version of your bank statement.

2 Electronic. For working from a .CSV (Comma Separated Values) file provided by your 

bank.

Either of these methods will essentially go through the process of matching unreconciled 

transactions from the selected GL bank account (payments, receipts, banking batches, etc) 

with entries that appear on the statement provided by your bank. You will be able to add 

extra transactions for bank fees and process any automatic payments (direct debits) 

received.

N O T E

You can use the reconciliation process on any of the General Ledger accounts. 

Reconciliations can be carried out on multiple GL accounts concurrently.

Once all items from the bank have been matched with those in the GL bank account, any 

remaining unreconciled transactions in the GL Bank Account should represent the 

difference between the balance of the GL bank account and the bank’s closing balance.

You can run either or both methods of reconciliation for the one bank account (e.g. 

manual or electronic).
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Review Existing Bank 
Reconciliations

Utilities > Bank Reconciliation

Open the Bank Reconciliation Utility . This starts the Finance module and opens the 

reconciliation utility.

1 Choose the bank account you wish to review from the GL bank account drop down 

list.

2 Search previous reconciliations. Click Search to show a list of previous 

reconciliations (these will appear automatically if the Auto Load option is selected). 

Previous reconciliations can be edited if your profile allows.

3 Review and/or edit previous bank reconciliation as required.

Bank reconcilation search screen
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Manual Bank Reconciliation

If you are not planning to edit or review an existing reconciliation, you can start a new 

reconciliation. The steps to complete a reconciliation are as follows:

1 Start a new reconciliation

2 Reconcile transactions

3 Add or remove transactions as required

4 Check the bank reconciliation

5 Print reconciliation report

6 Save the reconciliation

i) Start a new reconciliation

1 Open Bank Reconciliation search screen via the path Utilities > Bank Reconciliation.

2 Start a new reconciliation by clicking New on the menu bar of the bank 

reconciliation search screen.

3 Enter the reconciliation details as follows:

• GL Bank Account (should default to the bank account chosen previously).

• Reconciliation Number - the system will provide this number as an increment from 

the last reconciliation number used. It can be changed (for example to the bank 

statement number) but cannot be the same as a number that has been used 

previously on this GL bank account. 

• Select unreconciled transactions up to and including. Enter the reconciliation date. 

For example: If, on the 11th March, you want to run a reconciliation for 4th March 

2011, key in the reconciliation date 4/03/2011 (or select from the popup calendar). 

New Bank Reconciliation
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The system will obtain the GL balance at 4th March and present unreconciled 

transactions up to and including 4th March ready for reconciliation.

• Date of closing bank statement: this is held for information purposes, to easily 

identify which statement file is being reconciled (for example, you may want to 

conduct two fortnightly reconciliations from the one monthly bank statement).

• Reconciliation type. In this example it is manual.

• Click OK to enter the setup information and the bank reconciliation details screen will 

appear.

ii) Reconcile transactions

The left hand side of the reconciliation screen shows a list of the unreconciled 

transactions from the GL Bank Account. The right side of the screen shows transactions 

that appear on the bank statement.

N O T E

When using manual reconciliation, the transactions move from left to right when 

reconciled (e.g. we clear the left side). For CSV reconciliations the right side of the panel 

will be cleared.

1 Check the Bank Reconciliation header information. Most of these are set by the 

system and cannot be changed.

• GL Balance as at dd.mm.yy - Shows the GL balance at the date specified for the bank 

reconciliation.

Bank Reconciliation Details
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• Reconciliation Type. Set to manual when starting the reconciliation. If you wish to 

change it, cancel out of this reconciliation and start again.

• Locked: The reconciliation can be edited until the checkbox is ticked. When a bank 

reconciliation is complete we recommend that you ‘‘lock’’ it via this checkbox.

• Bank Statement Opening Balance: this is set to the closing balance from the previous 

reconciliation and cannot be changed unless it is the first reconciliation for this 

particular GL account.

• Bank Statement Closing Balance (at dd.mm.yy): is the opening balance plus all 

transactions that appear on the bank statement (i.e. those on the right hand side of 

the screen). Again this cannot be changed.

2 Reconcile transactions as required. To mark transactions as reconciled (ie to move 

to the right hand side of the reconciliation screen) either:

• Double-click on the item, or

• CTRL+Click multiple items and then click the  button on the toolbar.Press the 

Spacebar with the relevant transaction highlighted.

3 Unreconcile a transaction by Double-clicking on the item on the right side screen to 

move it back to the unreconciled (left side) screen.

Reconciliation Tools

There are some useful tools available to assist in running your bank reconciliation.

1 Search. To find transactions by cheque number or an amount .

2 Calculate Selected: to sum a series of selected transactions.

3 View Banking Batch: to view the batch a transaction belongs to (right click).

4 Exogrid. To reorganise how information is viewed in the grid.

5 Arrow Keys. To reorder transactions in the grid.

Search tool

Use the search function to assist in finding transactions from either side of the 

reconciliation.
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1 Click the Search button on the toolbar. The search panel will appear above the 

reconciliation lists.

2 Enter the search criteria and click Find.

• Cheque Number must be an exact match

• Amount is an absolute value (ie 100.00 will find either Positive or negative that 

amount).

• +/- provides the variance, so 100.00 +/- .50 will return values between 99.50 and 

100.50, as well as -99.50 and -100.50 (ie debits or credits).

• Details. Enter text to return any entries that contain the text specified here.

3 Transactions that match all of the search criteria will be highlighted in red and the 

total number of transactions found will be shown at the top of each column.

4 Hide the search panel by clicking on the Hide button when you have finished 

searching.

Search Panel
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Calculate Selected Tool (F5)

The Calculate Selected function is useful for fast calculation of a series of transactions on 

either side of the reconciliation screen. This function may be useful if you have a series of 

receipts entered individually that have not been batched.

1 Select the transactions you wish to add by CTRL+Click. A tick will appear in the Sel 

column. 

2 Calculate the sum of the transactions by clicking on calculate Selected in the menu 

bar.

3 View the total at the bottom of each screen as shown above. 

4 Unselect the transactions by clicking on any other transaction.

View Banking Batch

If the transaction you are reviewing on the reconciliation screen is part of a banking batch, 

right click on the transaction to view the banking batch it is part of.

Exogrid

The bank reconciliation screens are an Exogrid, and so can be sorted, columns removed or 

resized as appropriate.

Calculate Selected
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Arrow Keys

As each item is reconciled, it is placed on the right hand side list in the order that it is 

reconciled. You may find it easier to move through the reconciliation with items placed in 

the order they appear on the bank statement. The up and down arrow keys located above 

the Bank Statement transactions list enable you to move transactions in the bank 

statement to a different Position on the list.

1 Click to select the transaction you wish to move. 

2 Click on the up or down arrow until the transaction is in the desired Position on the 

list.

iii) Add or remove transactions

Add Items to the Bank Reconciliation

The integrated cashbook feature of EXO Business is available from the Bank Reconciliation 

screen. It enables you to add transactions relating to bank fees, interest, foreign exchange 

accounts and other cash transactions which haven’t been processed by debtors or 

creditors.

1 Make a new cashbook entry. Select Tools > Make Cashbook Entry. The system will 

save any reconciliation information entered to date and take you to the Cashbook 

Entry screen.

2 Enter a new transaction by clicking new.

Most commonly your cashbook entry during processing of a bank reconciliation will either 

be X for Expense (bank fees), or I for Income (interest income).

Remove Items from the Bank Reconciliation

When two or more items in the list of unreconciled GL transactions balance each other 

out (ie, net to zero) they can be removed from the list of unreconciled GL transactions. 

This is useful when transactions have not appeared on the bank statement, even though 

they have gone through the GL bank account. For example, a payment received via credit 

card which did not go through correctly to the bank.

1 Select the transactions by Ctrl-clicking on each row. The transactions should be 

highlighted with the checkboxes ticked (for example, the original payment as well as 

the negative payment entry to reflect the fact that it did not go through to the 

bank).

2 Select Tools > Remove From General Ledger. The transactions will be removed from 

the left hand side and flagged as ‘‘reconciled’’. They will not appear on the right 

hand side ‘‘Transactions appearing on the Bank Statement’’.

Remember, the transactions must net to zero. If they do not, the system will not allow the 

entry and will return a message ‘‘This function reconciles items on the same side of the 

ledger. Amounts must total zero to reconcile.’’
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iv) Check the Bank Reconciliation
Tools > Check Reconciliation

When all reconciled transactions have been moved over to the ‘‘Items appearing on the 

Bank Statement’’ column, you need to check that the current reconciliation balances.

1 From the Bank Reconciliation screen, go to Tools > Check Reconciliation. 

2 Click OK to continue. If the reconciliation difference is zero, it balances and you can 

print the full bank reconciliation report. If not, you will need to check through the 

bank rec again to see why it doesn’t balance. Refer to ‘Common Issues with Bank 

Recs’ on page 48 for some techniques to address an unbalanced reconciliation.

v) Create the Bank Reconciliation Report
Reports > Bank Reconciliation Details

Once the reconciliation is balanced, you should run and print the Bank Reconciliation 

Report.

1 From the Bank Reconciliation screen select Reports > Bank Reconciliation Details.

2 The system will produce the bank reconciliation Details report. 

3 Print the report using the Print button on the toolbar, or 

4 Save the report by using File > Save As. If you save it in a .CSV format, the data can 

be taken into a spreadsheet program for analysis.

vi) Save the Bank Reconciliation
Once your reconciliation balances and has been reported on, you should save the 

reconciliation. You can also save a partly completed reconciliation to work on at another 

time if required.

1 Save the reconciliation by clicking Save in the toolbar or File > Save.

Check Reconciliation screen
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If you do not want to save the reconciliation, click cancel to go back to the 

search/summary screen.
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Common Issues with Bank Recs

Bank Reconciliation doesn’t Balance

There are many reasons why a bank reconciliation may not balance. Listed below are 

some steps to follow if your reconciliation doesn’t balance.

1 Check that each transaction appearing on the bank statement has a matching item 

reconciled across from the GL on the right hand side of your reconciliation screen. (It 

may help at this point to use the arrow keys to organise the transactions in order on 

the right hand column as outlined in Reconciliation Tools earlier in this section.) 

2 Check each transaction amount matches that on the bank statement (e.g. a 

transposition error - $125.52 may be represented as $125.25).

3 Check that bank fees, interest, etc have been added.

Once you have gone through these steps you may need to use the following suggestions 

to address any other discrepancies.

Can’t find transaction in the GL list

1 Check the transaction date is within the range of the current bank reconciliation. 

2 Check that the transaction has been Posted to the GL via Post Creditors to GL, Post 

Debtors to GL. 

3 Check that the payment/receipt has been allocated to a purchase/sale.

Can’t Find Debtors Banking Batch in the GL

If a banking batch appears in the bank statement but not in the GL list:

1 Check that the batch has been Posted to the GL.

• Transactions > Debtors Receipts > Debtors Banking Batches

• Search for the banking batch (ie use date range, check the Branch, etc and click 

Search). If the GL column = N, then the batch has not been Posted to the GL.

• Open the batch and click the Post to GL button in the toolbar.

• Check the date on which the batch was Posted to the GL to ensure it is prior to the 

bank reconciliation date.

Banking Batch does not match Bank

1 Review the original accounts to check that the amounts have been entered 

correctly. You will need to check that each individual entry in the batch matches its 

corresponding remittance.

2 As a last resort, obtain a copy of the image from the bank to determine error. 
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3 To correct any data error, go to the Transactions > Debtors Receipts > Debtor 

Receipt to enter a Positive or negative payment adjustment.

Creditor Payment does not match Bank

1 Review the original accounts to check that the amounts have been entered 

correctly. 

2 If a payment has been entered incorrectly reverse and re enter payment. 

3 If a Creditors adjustment is required, go to Transactions > Creditors Adjustments to 

enter an adjustment against the creditor using the appropriate predefined 

adjustment type (e.g Correction).

I M P O R T A N T

A Creditors or debtors adjustment should be a rare transaction not a common transaction.

Dishonoured Payments

If a payment has been dishonoured by the bank, then you can use one of the previously 

mentioned payment reversal methods to correctly reflect this change.
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Skills checklist
Tick the skills that you have learned in this unit.

Skills

Complete a manual bank reconciliation
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End of 
Period

In this unit you will learn 
how to process an end of 
period.

By the end of this unit, you will be able to:

Process an End of Period

Process an End of Financial Year
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End of Period Process

EXO Business is a period-based accounting system. While transaction dates are recorded 

for reference purposes, it is the period to which a transaction is posted that determines 

when it is reflected in the financial statements.

In accounting terms, periods determine the intervals at which the financial statements will 

be prepared. The End of Period is the point in time where current period transactions are 

totalled to determine the profitability for the period (Profit and Loss) and the net worth of 

the business (Balance Sheet).

The transactions are then cleared from the current period and moved to the first prior 

period so that new transactions can be entered into the new current period. EXO Business 

handles this automatically via the End of Period roll.

Posting is the process of telling EXO Business which period you want the transaction to 

belong to.

When transactions are posted, they are ‘‘tagged’’ with a nominated period number (up to 

24 periods prior depending on your configuration). Transactions cannot be posted to 

future periods, so if you are entering transactions for a new period, it is essential to roll 

the ledgers to create a new current period. Transaction details remain accessible 

following an end of period / end of year process.

In order to ensure that the integrity of financial information is maintained, there is a 

clearly defined process for conducting an End of Period.

An End of Period process takes all unposted current period entries (Period 0) from the sub 

ledgers, posts them to the General Ledger (still Period 0) and then ‘‘rolls’’ them back to 

the first prior period (Period 1).

In the example below, transactions from May 2013 (current month, or Period 0) are posted 

to the GL on 31st May 2013. They are posted to the general ledger in the current period 

(Period 0).

After posting, when the period is rolled , the May 2013 transactions will be moved back to 

Period 1 (first prior period) providing a clean current period (Period 0) for you to 

commence entering June 2013 transactions.
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Before rolling

After rolling on 31st May 2013

Remember that once the end of period / end of year process is completed, transactions 

can still be posted to prior periods if required (even to the previous financial year). You 

will also still have access to previous year’s transactions for reporting and for posting 

information to (if your profile allows).

N O T E

EXO Business automatically creates a journal to update retained earnings if you post to a 

period from a prior financial year. 

Current 

Month
Period 0 Period 1 Period 2 Period 3

May 2013 May 2013 April 2013 March 2013 February 2013

Current 

Month
Period 0 Period 1 Period 2 Period 3

June 2013 June 2013 May 2013 April 2013 March 2013
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The End of Period Procedure

1 Backup Data

2 Finalise entry of transactions for the period

3 Post sub-ledgers (Debtors, Creditors, Stock) to the General ledger

4 Print reports as required (Debtors, Creditors, Stock and General ledger) and check 

that the sub-ledger report totals balance with control accounts in the General 

ledger.

5 Backup Again.

6 Roll each of the sub-ledgers (Debtors, Creditors, Stock) and the General ledger so 

that transactions can then be entered into the new period.
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Step 1. Backup Data

Your implementing partner will almost certainly have instigated an automatic backup 

cycle for your database. However it is imperative to run an additional backup prior to 

rolling End of Period and to keep this backup file in a secure place.

The traditional method for backing up EXO Business database files is through Enterprise 

Manager. Alternatively, there are useful utility available on the internet that helps to 

streamline the process.
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Step 2. Finalise Transactions

Finalise Debtor Transactions
1 Process sales and generate invoices for supplied sales orders. If this is not completed 

prior to running the month end reports, then the debtors aged trial balance and 

stock valuation will not reflect the true state of the business. While a debtors aged 

trial balance can be run for a prior period, the stock valuation report only runs as at 

the current date. 

2 Ensure debtor payments have been entered and allocated. 

3 Debtor Bank batches. All batches that have reached the bank should be posted prior 

to month end. If banking will reach the bank after month end, see your 

implementing partner to enable a profile to exclude these from the postings.

Finalise Creditor Transactions
1 Enter all expense invoices.

2 Ensure creditor payments have been entered and allocated via Creditors Payment 

Processor. 

3 Ensure all costed inwards goods transactions have been converted to creditor 

invoices. Print the Purchases Clearing report to show any inwards goods 

transactions that have not yet been fully processed.

Finalise Stock Transactions
1 Stock adjustments. Any stock adjustments required should be entered prior to 

month end roll so that they are properly reflected in the stock valuation reports and 

the GL. If you are running end of year it is recommended that you run a stocktake 

prior to rolling.

2 Ensure all stock receipts and goods costings are completed (see creditor 

transactions).

Stock is not shown as received until it is costed via the Inwards Goods Costing process. 

While inwards goods costing can be backdated, the stock valuation report will not agree 

with the stock in the GL if costings are not completed until after the month end reports 

are run.
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Finalise General Ledger Entries
1 Process any recurring journal entries. 

2 Enter any other general journals required. 

3 Undertake a Bank reconciliation 

4 Enter Foreign Exchange variances (see following). If you are not using foreign 

currency you can skip the foreign exchange variance entries and go straight to Step 

3: Posting.

While individual transactions can be posted to prior periods, banking batches, payment 

processor and debtor payment batches post transactions to the GL in the current period. 

They do not have a period selection capability so must be carried out in the correct period.
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Foreign Exchange Variance

Utilities > Foreign Exchange Rate Variance Calculator

This is quite a simple procedure, however must be carried out prior to rolling. The Foreign 

Exchange Rate Variance Calculator calculates the foreign exchange variance based on the 

rates specified in the currencies table, so you must first update the current exchange rate 

for the relevant currencies.

Update Exchange Rates
1 Open exchange rate setup. Setup > Setup Currencies.

• Open the currency. Double-click on the relevant currency in the table and update the 

purchase rate and sell rate as appropriate.

• Save updates. Click Save and open any other currencies for updating as required.

The ageing analysis and Balance figures on the converted aged trial balance report are 

calculated on the foreign currency transaction amounts converted at the rates you have 

specified above. The calc bal figure on both the converted and unconverted reports 

represents the rate at which the transaction was converted at the time of entry - this is 

the figure that has been posted to your debtors control account).

Currencies Table
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Print Exchange Rate History
1 From the Reports menu, choose Currency Reports and then Exchange Rate Change 

History report. Print as required.

Run Foreign Exchange Rate Variance Calculator
1 Open the Foreign Exchange Rate Variance Calculator. Utilities > Foreign Exchange 

Rate Variance Calculator.

2 Select the periods or dates to source the transactions from, using the Source Ledger 

Period / Date Range control. The four options available are:

• All unposted - All unposted transactions

• Prior to Current Period - Everything except the current financial period.

• Selected Period Range - Selecting this option lets you choose a From and To period 

to determine the source range.

• Selected Date Range - Selecting this option lets you choose From and To dates to 

determine the date range

3 Choose the Destination GL Periods for your Realised, Current and Unrealised Foreign 

Exchange Variances, this can be the source ledger period or it can be a custom GL 

period

Foreign Exchange Rate Variance Calculator
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4 Check for Unallocated Payments. Click on the Unallocated Payments Report on the 

menu bar. Since the allocation of payments is critical in running an accurate variance 

report, any unallocated payments should be addressed.

• Print the unallocated Payments report.

• Allocate any Unallocated Payments: using the appropriate allocation tools in the 

debtor/creditor accounts. 

• Re-run the unallocated payments report until all outstanding payments are allocated.

N O T E

Posting foreign exchange variances to the current period (0), the previous revaluation is 

reversed before a new auto-reversing journal takes place. When posting to a previous 

period (age 1), the existing valuations in age 1 are reversed and the new ones are entered 

for the period. These then auto-reverse themselves out in the next period, i.e. age 0. In 

addition to this any existing foreign exchange auto-reversals in age 0 are reversed out as 

well..

5 Use the Recalculate option to refresh the Foreign Exchange Variance Calculator.

6 Print the following Foreign Exchange reports::

• Creditors Gains/Losses Report

• Debtors Gains/Losses Report

• GL Accounts Gains/Losses Report

• Detailed Report

• Summary Report

7 Post to GL. Click post to GL to post the variance transactions to the General Ledger.

N O T E

 It is not possible to re-allocate a fully allocated foreign account transaction that has been 

part of a foreign exchange varience. Attempting to do so prompts the message “Cannot 

reallocate a fully allocated transaction that has been a part of Realised Forex Variance”.

Review Foreign Exchange Variance Batch
Utilities > General Ledger Utilities > GL Batches Review
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To review the foreign exchange batch that has been created, click on GL Batch Review 

under the General Ledger menu or use the path outlined above. Double-click to open the 

GL batch to review individual transactions generated.

N O T E

The reversing journal for unrealised foreign exchange variances is created automatically 

when the period is rolled.

Foreign Exchange Variance Batch
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Step 3. Post Sub-Ledgers to GL

The sub-ledgers in EXO Business can be posted to the GL separately, or all sub-ledgers 

(debtors, creditors and stock) can be posted together.

When ledgers are posted separately it is easier to review batches later on.

To post ledgers to GL

Utilities > Ledger Postings > Post Ledgers to GL > Post Debtors to GL

1 Ensure that the Debtors, Creditors or Stock ledgers are ticked. 

2 Tick Exclude debtors payments if you do not want to post debtor payments. If 

debtor payments are posted then they can no longer be batched to facilitate the 

bank reconciliation. 

3 Enter posting details, including your initials and a description: 

N O T E

If you wish to post subledgers separately, tick only the ledger you wish to post at this time 

(e.g. Creditors only). The Debtor and Creditor subledgers offers further segregation. These 

options are controlled by user level profile settings . You will need to remember to post 

the other ledgers prior to rolling.

• Source Ledger Period. Debtor period that the transactions are being extracted from: 

and to:

• Destination GL Period: GL period to post to.

N O T E

To ensure that the ledger periods match leave the Destination GL Period as Source Ledger 

Period. This ensures that extractions from Period (X) are also posted to Period (X). If there 

is more than one source ledger period in the one extraction (ie aLL unposted), then there 

will also be multiple Destination GL Periods (unless you have specified a Custom GL 

Period).

4 Extract transactions. Click on View Unposted TRX to view any unposted debtor 

transactions from the specifed period without posting. Choose a particular period if 

required and then drill down on a transaction to view further detail.

5 Generate a preview of the post run by clicking on the button Preview GL Post Run. 

This will summarise and give you an opportunity to view the transactions without 

posting to the GL.
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6 Generate a post run by clicking on the New GL Post Run button. This will create a 

suspended journal batch and mark the extracted transactions as posted, however it 

will not actually post them yet. A separate batch will also be created for each ledger 

and period, e.g. if you are posting the Debtors and Creditors ledgers for October and 

September, four batches will be created (Debtors - October, Debtors - September, 

Creditors - October, Creditors - September).

7 The proposed batch can then be printed or edited. Right click on the Postrun name 

(Gl postrun #xx for GL period October 2012) to print or edit as follows:

• Description allows you to edit the postrun description 

• General ledger period allows you to change the period to which the transactions are 

posting.

• Fix imbalance. If the postrun is out of balance by a small amount (under a 

predetermined threshold) Fix imbalance will generate a rounding transaction. If the 

imbalance is larger than than the predetermined amount you will require a 

supervisor’s password.

8 Once the batch is balanced and you are satisfied that the data is correct you can click 

the Process GL post run icon in the toolbar to commit the suspended journal batch 

to the GL.

Editing the GL Post Run batch
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Check prior period unposted transactions
Some transactions may have been entered into prior periods during the month (i.e. 

invoice generated in the current month and backdated for services completed in the prior 

month). These must be picked up and posted to the corresponding prior period in the 

general ledger.

1 Click on the arrow next to view unposted TRX and then debtors transactions to 

review a list of unposted debtor transactions for a specified prior period. 

• Specify the period (any Period) and click Scan. 

• Print the unposted transactions if required.

2 Rerun the extraction using the specified period and post these to the matching prior 

period in the General Ledger.

N O T E

If your source ledger period in the initial extraction is All unposted, and your destination 

ledger period is source ledger you will not need to check for unposted transactions. These 

will already have been picked up by the initial extraction.

Individual Posting of Ledgers
It is possible to post ledgers separately to the GL. If you wish to do this, simply select only 

the ledger you wish to post before generating the postrun.

Reload GL Postrun
It is possible to have multiple unposted GL post runs ready for editing. You may have one 

post run for debtors and stock, and then a separate postrun for creditors. To access a 

postrun which has already been created (but not posted) click on the Reload GL Post Run 

icon from the toolbar and double click to open the appropriate batch. It is now available 

for editing and/or processing as required.
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Step 4. Check Balances and Print 
Reports

Check Subledgers reconcile to the GL
Once data has been posted from the sub-ledgers, you must ensure that the following sub-

ledger reports balance with the appropriate control accounts in the General Ledger.

Reconcile Debtors
1 From the End of Month module, click Reconcile Receivables Account to run a report 

that will check for imbalances between the Debtors ATB and the Debtors control 

account in the General Ledger. The Debtors Control Account and the Debtors Aged 

Trial Balance (Retrospective) are shown on the following page.

Sub-Ledger Report Control Account

Debtors Aged Trial Balance Total = Debtors Control Account in the Balance 

Sheet

Creditors Aged Trial Balance Total = Creditors Control Account in the Balance 

Sheet

Stock Valuation total = Stock on Hand in the Balance Sheet

Reconcile Receivables Account report
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Debtors Control account in the balance sheet
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Debtors Aged Trial Balance (Retrospective) Report
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Reconcile Creditors
1 From the End of Month module, click Reconcile Payables Account to run a report 

that will check for imbalances between the Creditors ATB and the Creditors control 

account in the General Ledger.

Reconcile Stock / Inventory
1 From the End of Month module, click reconcile inventory account to run a report 

that will check for imbalances between the Stock Valuation Report and the 

Inventory control account in the General Ledger.

If Accounts do not balance:
1 o Check for unposted transactions and ensure they are posted to the correct period 

(see previous section). 

Reconcile Payables Account - report extract

Reconcile Inventory Account - report extract
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2 Debtors - deduct from the Debtors control account the value of any unposted 

debtor payments as well as any posted deposits (check the Deposits account in the 

GL).

3 Print out sales / purchases / stock reports as appropriate and reconcile against the 

GL account. This should highlight any discrepancies. 

4 Print out adjustments listings and check the adjustment accounts. 

5 Make sure that you have run the Foreign Exchange Variance Calculator and posted 

the resulting journals to the general ledger.

6 Check that journals have not been posted to the control accounts. This is normally 

disallowed in most configurations however under certain circumstances this 

function may have been enabled. Check with your Implementing Partner.

N O T E

Refer to your accountant or implementing partner if you cannot find the cause for the 

imbalance. Problems can become more difficult to correct if they are left over a long 

period of time.

Check Clearing Accounts
Check the following clearing accounts in the balance sheet to ensure that purchases have 

been processed as far as possible prior to month end.

Account Actions if not zero

Stock Clearing Account Run the Purchases Clearing report to identify incomplete 

Inwards Goods Costings in the system.

Finalise Inwards Goods costing as appropriate.

Oncost Clearing Account Create a creditor invoice and review the oncosts yet to be 

invoiced (remember to toggle to stock.) Invoice those 

oncosts for which you have received the creditor invoice.

Stock Adjustments 

Account

A figure in the stock adjustment account generally arises 

from stocktake variances or manual stock movements. 

The Stock on Hand figure has been adjusted for these 

transactions. Write an adjustment journal to the 

appropriate P&L Account (usually Cost of Sales)

• DR Cost of Sales

• CR Stock Adjustments
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If you have had to make adjustments or process more transactions, run through Step 3: 

Posting and Step 4: Reporting 

Print Reports
Once you are satisfied that your data is balanced and accurate, you should print reports to 

maintain a view of your company’s accounts at the end of each period.

As each business is unique, reporting requirements vary greatly. The following are some 

examples of reports you may wish to print and save at the end of each period.

Print Debtor Reports

Print all required debtor reports and statements (especially any involving year to date 

totals etc).

Stock Variance Account A figure in the stock variance account generally arises 

from differences between the costed price from an 

inwards goods costing and the price entered on the 

creditors invoice. Write an adjusting journal to the 

appropriate P&L account (usually Cost of Sales).

• DR Cost of Sales

• CR Stock Variance

GL Trial Balance Tree showing Stock and Oncost Clearing acounts.
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1 You must print Debtors Aged Balance report (you may wish to print the detailed 

version as well as the summary).

2 If you are running multi-currency you should print the Debtors Aged Trial Balance 

(retrospective) with currencies converted and unconverted (ensure you have 

updated your currency buy and sell rates as at the end of the period before running 

the converted report). 

3 Print Debtor Statements prior to rolling unless you have validated your prior period 

statements are working correctly.

Print Stock Reports

Print any required stock reports such as Stock Valuation and Stock Sales reports.

1 You must print the Stock Valuation report for each location and in total.

2 Print a stock movement report -- for example the Stock Transactions report.

Print Creditor Reports

Print all required creditor reports (especially any involving year to date totals etc).

1 You must print Creditors Aged Trail Balance (retrospective). (You may wish to print 

the detailed version as well as the summary) If you are running muti-currency you 

should print the Aged trial balance reports with currencies converted and 

unconverted (ensure you have updated your currency buy and sell rates as at the 

end of the financial year before running the converted report) The Calc Bal figure on 

both of these reports represents the rate at which the transaction was converted at 

the time of entry -- this is the figure that has been posted to your creditors control 

account.

2 A purchases report for the month and for the year e.g. Purchases by Supplier report.

Print GL Reports

Print and save all required general ledger reports, as a minimum:

1 Balance Sheet (for all branches individually as well as consolidated)

2 Profit & Loss (for all branches individually as well as consolidated)

3 General Ledger Trial Balance Report

If you have multiple branches and need to run reports by branch, then these can be setup 

to run as a batch using the utility ‘‘Setup GL Report Batches’’. Details about this utility 

have been covered in the first section of this module.
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Step 5. Backup Again

During steps 2 - 4, a significant amount of processing, etc. will have taken place. We 

strongly recommend a second backup be taken just prior to running the period end roll. 

See Step 1: backup data for details about backing up.
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Step 6. Roll End of Period/Year

The period must be rolled so that transactions can be entered for the new period. Many 

organisations use a calendar month as a period, so the End of Period tends to be run at 

the end of each calendar month. If you have any queries about when to run End of Period, 

check with your accountant or implementation partner.

The End of Period, or roll-over, procedure ages the transactions (ie sets current period 

transactions (period 0) to previous period (period 1), ages the Debtor and Creditor 

balances and resets various cumulative month to date totals to zero.

Once the roll is completed, transactions can be entered for the new current period.

Separate Rolling of Ledgers

Separate Rolling of Ledgers

While we recommend that the four ledgers are rolled simultaneously, in certain 

circumstances it may be appropriate to roll the ledgers separately. For example, in a real-

time retail environment the Debtors and Stock ledgers must be rolled before opening of 

business on the first of the month. However you may also want to spend additional time 

finalising transactions in the Creditors and General Ledgers prior to rolling these ledgers.

If ledgers are rolled at separate times they will be ‘‘out of sync’’ with each other and extra 

care needs to be taken when processing and posting transactions. If you are not confident 

that you can manage disparate periods, the best practice is to roll all your ledgers at the 

same time and age any creditors and general ledger transactions back to the prior period.

I M P O R T A N T

Debtors and Stock Ledgers must be rolled at the same time. Creditors and General Ledger 

are generally rolled together.

Roll End of Period

To roll end of period

1 Open the End of Period utility (utilities > End of Period)
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2 Select the ledgers to roll (it is advisable to roll all ledgers together, however you may 

choose to roll them separately if required). At the very least, stock and debtors 

ledgers must be rolled at the same time.

3 Click OK to roll End of Period.

End of Period Outcomes

End of Period Outcomes

During the process, the system will:

• Take a snapshot of the data for use in EXO Business Analytics.

• Set period totals.

• Set month totals. 

• Copy aged balances to last period balances.

• Set aged balances. 

• Increment the transaction age. 

• Increment the allocation age. 

• Update the allocation statuses.

Roll end of Period
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• Age the period status.

• Roll the period status.

• Re-values the unrealised gains/losses for the month and sets the closing rates.

Once this has been completed successfully you will be ready to commence entering 

transactions into the new current period.

Roll End of Financial Year
End of Financial Year must be run so that transactions can be entered into a new financial 

year. It is imperative that the End of Financial Year is run at the same time as the End of 

Period for the last period of the financial year.

End of Period and End of Year procedures are essentially the same, however when 

running the End of Year, the End of financial year checkbox must be ticked in addition to 

the roll Debtors, roll Creditors, roll Stock and roll General Ledger checkboxes. This means 

that End of Period and End of Year occur at the same time.

If required you can roll End of financial year separately for each module (except Debtors 

and Stock which must be rolled together), however it is recommended that all ledgers be 

rolled at the same time with the End of financial year checkbox ticked.

End of Financial Year Outcomes
The End of Year follows the same processes as End of Period. In addition, it:

• Re-values the unrealised gains/losses and sets the closing rates

• Moves year to date totals into last year.

• Resets the year to date totals to zero.

End of Financial Year
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• Profit and Loss current year movements are cleared and final balance posted to the 

retained earnings account as defined in the GL Control account screen.

Once this has been completed successfully you will be ready to begin entering 

transactions into the new financial year.
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Skills checklist
Tick the skills that you have learned in this unit.

Skills

Process an End of Period

Process and End of Financial Year
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Business Activity 
Statement

In this unit, you will lean 
how to run the Business 
Activity Statement

By the end of this unit, you will be able to:

Use the BAS Tax Return utility.
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Business Activity Statement/GST

Reports > Tax Reports > GST Tax Return

The business activity statement is run using the BAS Tax Return utility which is found on 

the Utilities screen or via the reports menu outlined above.

The GST can be run on a period basis or a date basis, however we generally recommend 

using a period based GST as it reduces imbalances which can arise from transactions dated 

in a current period and posted to a prior period.

The data that is used for the GST Tax Return is based on the tax return key points set up 

when your database was implemented.

It is recommended that the following occurs prior to running the GST for a particular 

period:

• End of period process (including post Debtors, Creditors and Stock and checking of 

balances). See previous section End of period processes. 

• Bank reconciliation 

Business Activity Statement Procedure
1 Enter the GST header information & calculate entries

2 Reconcile GST report

3 Enter manual figures required

4 Print/Export the GST report

5 Save the GST tax return

6 Enter Payment/refund details
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1. Enter the GST Header 
Information & Calculate

1 Open the GST Tax Return utility using the menu options outlined above or going to 

the Utility screen and clicking GST Tax Return.

2 Enter information into the Header tab as required.

• Tick Include Previous if you post transactions to prior periods that may not yet be 

included in a GST return. 

• The Tax Return Code will be assigned to each transaction that is included when the 

GST is saved to ensure that they are only included in one GST return (e.g. Nov07).

N O T E

If you are using period based GST, the calculation will be based on the periods you specify 

on the right side of the screen, and the dates on the left are not referred to.

3 Click calculate in the toolbar to calculate the GST entries based on the period (or 

dates) and tax basis specified in the header.

BAS Tax Return Header
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4 Click Print to print a summary report of the GST return, or click the Summary tab to 

view on screen.



© Copyright 2013 MYOB Technology Pty Ltd

Unit 6—Business Activity Statement

 81

2. Reconcile GST

Reports > Tax Reports > Tax Report by Rate Type

The GST needs to be reconciled against both the GST collected and GST paid accounts in 

the general ledger as well as the tax report by rate type report.

Run and print the tax report by rate type (path above).

Tax Return by Rate Type
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Check that the totals provided in the Tax Report by Rate Type match the figures returned 

in the GST Summary.

If the figures do not match:

• Check that you are looking at matching periods/dates for both reports and rerun the 

reports. 

• If you have ticked ‘‘ Include Previous’’ in the GST header it will pick up transactions 

that have been posted to prior periods but have not yet been included in a BAS 

return. These will not be included in the tax report by rate type report.

• From the GST, click Source transactions in the toolbar to review the source 

transactions. As these are in an Exogrid you can sort by period to quickly see any 

transactions from prior periods.

BAS Summary tab
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• Alternatively to view source transactions from a particular key point, double click on 

that field (ie double click the field G1 to look at the source transactions that make up 

that amount).

• From the Source transactions screen you can generate a report or Export the details 

to a .CSV file for further review as required.

Reconcile against General Ledger accounts
Compare the GST payment/refund amount in the summary tab of the GST Tax Return (key 

point 9) against the GST Collected and GST Paid Accounts in the general ledger. Review 

the source transactions if there are any discrepancies.

Source Transactsions G1
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3. Enter Manual Figures required

3. Enter manual figures required
When reviewing the GST return, fields that are grey are computed fields while white fields 

enable you to enter additional figures which are then calculated by EXO Business into the 

GST return. Depending on your business these could include:

• Wine Equalisation tax

• Luxury car tax

• PAYG Instalment amounts

• FBT amounts, etc.

Click on the relevant header tab to enter information as required. The following shows the 

PAYG Instalments tab as an example.

PAYG Installment tab on the BAS Tax Return



© Copyright 2013 MYOB Technology Pty Ltd

Unit 6—Business Activity Statement

 85

4. Print/Export the GST Tax 
Return

From the Summary tab, click Print or Export to print or export the BAS Return for your 

records and enter the details as appropriate into your formal return to be submitted.
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5. Save the BAS Return

Click Save to save the return. This will mark the included transactions with the tax return 

code listed in the Header tab and exclude them from future BAS Returns.
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6. Enter Recording Journals

Journal entries should be established to clear the GST collected and paid accounts to an 

GST clearing/ATO Payable account, as well as any other figures relating to PAYG Withheld, 

PAYG Instalments, etc.

The following example shows the debit and credit entries of a simple transfer to the GST 

Clearing/ATO Payable account.

Using the simple example above, when payment is made to the tax office, the transaction 

would be as follows:

N O T E

At this point you may wish to lock the period/s for which you have just generated the GST. 

See your systems manager about locking past periods.

Account Debit Credit

GST Collected 11,961

GST Paid 21,708

PAYG Tax Withheld 7,625

PAGY Tax Instalment 5,5054

ATO Payable 2,932

Account Debit Credit

ATO Payable 3,536

Bank 3,536
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Skills checklist
Tick the skills that you have learned in this unit.

Skills

Use the BAS Tax Return utility
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Goods and Services 
Tax NZ

In this unit, you will lean 
how to run the GST 
Return

By the end of this unit, you will be able to:

Use the GST Return utility.



© Copyright 2013 MYOB Technology Pty Ltd

GL, Reconciliation and End-of-Period EXO Business

 90

Goods and Services Tax NZ

Reports > Tax Reports > GST Tax Return

Goods and Services Tax NZ
The GST Return is run using the utility GST which is found on the Utilities screen or via the 

reports menu outlined above.

The GST can be run on a period basis or a date basis, however we generally recommend 

using a period based GST as it reduces imbalances which can arise from transactions dated 

in a current period and posted to a prior period.

The data that is used for the GST Tax Return is based on the tax return key points set up 

when your database was implemented.

It is recommended that the following occurs prior to running the GST for a particular 

period:

• End of period process (including post Debtors, Creditors and Stock and checking of 

balances). See previous section End of period processes. 

• Bank reconciliation 

GST Procedure
1 Enter the GST header information & calculate entries

2 Reconcile GST report

3 Enter manual figures required

4 Print/Export the GST report

5 Save the GST tax return

6 Enter Payment/refund details
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1. Enter the GST Header 
Information & Calculate

Reports > Tax Reports > GST Tax Return

1. Enter the GST Header information & Calculate
1 Open the GST Tax Return utility using the menu options outlined above or going to 

the Utility screen and clicking GST Tax Return.

2 Enter information into the Header tab as required.

• Tick Include Previous if you post transactions to prior periods that may not yet be 

included in a GST return. 

• Enter the Tax Return Code provided by the Inlard Revenue Department. The code 

details can be found at the top of the IR101a/IR103b forms. These forms are sent to 

you by the Inland Revenue Department. 
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• The Tax Return Code will be assigned to each transaction that is included when the 

GST is saved to ensure that they are only included in one GST return (e.g. Nov07).

GST Tax Return Header
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N O T E

If you are using period based GST, the calculation will be based on the periods you specify 

on the right side of the screen, and the dates on the left are not referred to.

3 Click calculate in the toolbar to calculate the GST entries based on the period (or 

dates) and tax basis specified in the header.

4 Click Print to print a summary report of the GST return, or click the Summary tab to 

view on screen.
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2. Reconcile GST

Reports > Tax Reports > Tax Report by Rate Type

2. Reconcile GST
The GST needs to be reconciled against both the GST collected and GST paid accounts in 

the general ledger as well as the Tax Report by Rate Type report. If you have additional 

GST general ledger accounts, these must be included in the reconciliation.

Run and print the Tax Report by Rate Type report (path above).

Tax Return by Rate Type
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Check that the totals provided in the Tax Report by Rate Type match the figures returned 

in the GST Summary.

If the figures do not match:

• Check that you are looking at matching periods/dates for both reports and rerun the 

reports. 

GST Summary tab
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• If you have ticked ‘‘ Include Previous’’ in the GST header it will pick up transactions 

that have been posted to prior periods but have not yet been included in a GST 

return. These will not be included in the tax report by rate type report.

• From the GST, click Source transactions in the toolbar to review the source 

transactions. As these are in an Exogrid you can sort by period to quickly see any 

transactions from prior periods.

• Alternatively to view source transactions from a particular key point, double click on 

that field (ie double click the field G1 to look at the source transactions that make up 

that amount).

• From the Source transactions screen you can generate a report or Export the details 

to a .CSV file for further review as required.

Reconcile against General Ledger accounts

Reconcile against General Ledger accounts

Compare the GST payment/refund amount in the summary tab of the GST Tax Return (key 

point 9) against the GST Collected and GST Paid Accounts in the general ledger. Review 

the source transactions if there are any discrepancies.

Source Transactsions G1
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3. Save the GST Tax Return

3. Save the GST Tax Return
Click Save to save the return. This will mark the included transactions with the tax return 

code listed in the Header tab and exclude them from future GST returns.
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4. Recording the IRD 
Payment/Refund

4. Recording the IRD Payment/Refund

There are two methods that can be used for processing the payment/refund:

• Journal entry

• Creditors invoice

Using the IRD code for the IR101a/IR103b statement as the invoice number, enter the 

values to clear each account as per your IRD lodgement.

Alternatively, you can record journal entries to clear the GST collected and paid accounts 

to an GST clearing/IRD Payable account.

The following example shows the debit and credit entries of a simple transfer to the GST 

Clearing/IRD Payable account.

Using the simple example above, when payment is made to the tax office, the transaction 

would be as follows:

N O T E

At this point you may wish to lock the period/s for which you have just generated the GST. 

See your systems manager about locking past periods.

Account Debit Credit

GST Collected 11,961

GST Paid 21,708

Account Debit Credit

GST Clearing/IRD Payable 3,536

Bank 3,536
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Skills checklist
Tick the skills that you have learned in this unit.

Skills

Use the GST Tax Return utility
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GL, Reconciliation 
and End-of-Period - 
Review

This unit will provide a 
list of questions to review 
what you have learned.
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1 How can a batch be edited?

2 What feature could be used to the save a journal that is not ready to post to the 

general ledger?

3 How might an auto-reversing journal be used?

4 How could a series of GL reports be run together?

5 Name two tools that can be used to assist when doing a bank reconciliation?

6 I have opened the current bank reconciliation, why can’t I edit it? 

7 Why must an end of period be run?

8 What does posting do and how does it affect transactions?

9 If you choose not to post debtors banking batches, how does this affect the debtors 

reconciliation?
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10 If scheduled backups have already been established, do you still need to backup 

prior to running an end of period?

11 If the post run has been generated, why do the figures not appear in the GL?

12 In what situation would the sub ledgers be rolled separately?

13 What two ledgers should always be rolled together?

14 What report should the Business Activity Statement be reconciled to?
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GL, Reconciliation 
and End-Of-Period - 
Activities

This unit will provide a 
list of activities to 
practice what was 
covered.
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Activity 1

View transactions

The lead up to Christmas is always a busy time of year for the sale of automotive 

accessories. You want to have a quick look at sales from this year compared to last year.

• What is the value of stock sold from the Accessories sub- account during the 

December 2008 compared with December 2007.

Dec ‘08: $1,802.49 Dec ‘07: $2,258.31

• What is the current value of the GST Collected and the GST Paid accounts?

GST Paid: 49,155.25 GST Collected: $38,327.57

• What are the respective amounts of GST Collected and GST Paid between October 

2009 up to December 2009

Activity 2

Enter GL Transactions

You need to enter depreciation for the current period.

1 Enter a journal entry to account for the following depreciation on computer 

equipment for Current period

• $1,353.00 for Computer equipment for Sydney (00) branch 

• $376.53 for Computer equipment for Melbourne (01) branch

• $1,064.34 for Computer equipment for Brisbane (02) branch

2 Please use the following accounts for each branch:

• DR Depreciation account 

• CR Accumulated Depreciation 

3 Save as a recurring journal. Name "MonthlyDepreciation"
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Activity 3

View GL Batches

You realise that the GL journals entered was incorrect. The amount for the Sydney branch 

was meant to be $1589 for that period.

1 Review the batches that you created in Activity 2.

2 Reverse the whole batch.

3 Re-enter the batch correcting the journal for current period. 

Hint: Right-click, copy to duplicate the transactions)

Activity 4

Auto-reversing journal

1 Your monthly direct credit for one of your staffs company cars has not left the bank 

due to the period closing early. You still need to acknowledge this expense. 

2 Enter a reversing journal for $981.82 (Don't forget GST!)

3 Process the following transactions:

Activity 5

Setup GL Reports

1 Copy the existing P&L Report. Rename P&L Budget Report. Add a budget column to 

the report. 

Hint: Utilise the preview to view the changes before saving.

Option 5a

Establish GL Budgets

You wish to create a new budget to compare your GL figures with, called "BestCase". 

1 Export the default budget for Motopartz to an Excel spreadsheet and make 

adjustments to some of the sales and expenses figures for the Sydney branch.

Dr/Cr Account

DR Repairs & Maintenance

DR GST Paid

CR Suspense
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2 Reimport the budget as a new budget to report against - "BestCase".

Activity 6

Setup GL Report Batches

1 Setup a batch that will print out P&L reports against each branches 1-6, specifying 

the default budget or your new budget if you have established one.

2 Please make sure you choose N to Print. 

Activity 7

Check clearing and adjustment accounts

Find the balances of the following accounts

1 Stock Clearing Account ________$3,090.96_______________

2 On Cost Clearing Account ______$5,504.84_________________

3 Stock Adjustment Account ______$836,451.25_________________

4 Stock Variance Account ______$0.00_________________

Activity 8

Post debtors ledger

1 Extract and review the extraction details.

2 Check debtors banking batches

3 If no further entries required, post. 

4 Check unposted entries from prior period and post to the corresponding prior 

period.

Activity 9

Post stock ledger

1 Extract and review the extraction details. 

2 If no further entries required, post.

3 Check unposted entries from prior period and post to the corresponding prior 

period.
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Activity 10

Post creditors ledger

1 Extract and review the extraction details. 

2 If no further entries required, post.

3 Check unposted entries from prior period and post to the corresponding prior 

period.

Activity 11

Check subledger reports

1 Print Debtors Aged Trial Balance and check it balances with the Debtors Control 

Account in the balance sheet.

2 Print Creditors Aged Trial Balance and check it balances with the Creditors Control 

Account in the balance sheet.

3 Print Stock Valuation total and check it balances with Stock on Hand in the balance 

sheet.

Activity 12

Bank Reconciliation

Generate a new bank reconciliation dated last day of the current period. Use the following 

bank statement to reconcile to the GL account.

Date Particulars Debit Credit Balance

Opening Balance 41,559.38

Customer Deposit 12,475.02
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Activity  13

Foreign exchange calculator

1 Run the Exchange Rate Variance Calculation, including checking unallocated 

payments, generating summary and detailed reports to the screen.

2 Note auto-reversing journals for unrealised gains/losses (invoices not yet paid or 

allocated).

Activity  14

Roll end of period

1 If all accounts show correct figures, then Roll Debtors, Creditors, Stock and GL at the 

same time.

2 Note: Do not tick the End of Financial Year checkbox!

EFT Deposit 29,081.15

Chq 78654 161.00

Emergy DD - Mercury 843.00

Chq 2499 Aussie Car Parts 4,836.81

Chq 2500 Telstra 756.55

Chq 2501 The Benefitz Ad 843.75

Chq 2502 Jensen & Roth 292.50

Chq 2504 G Gray Acc 1,287.50

Sydney Parts 110.44

Chq 2505 AMEX 2571.10

Returned chq James Barry

RETAIN FOR TAX 

PURPOSES

998.29

Closing Balance 70,414.61

12,700.94 41,556.17

The termination value of your account as at ...

The termination value could include uncleared funds, fees yet to be debited and interest 

not yet posted (less any Withholding Tax).
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Activity 15

Business Activity Statement

1 Calculate the BAS for period 1 (last period).

2 Run the Tax Report by Rate Type report and reconcile to the BAS statement.

3 Reconcile against the GL account for that period.

4 Save the return and enter the recording journals to establish the liability to the tax 

office.

5 How will you pay the tax office?
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